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Introductory Message 

For the facilitator: 

Welcome to the Empowerment Technologies Grade 11/12 Self-Learning Module 

(SLM) on Advanced Techniques using Microsoft PowerPoint! 

This module was collaboratively designed, developed and reviewed by educators 

both from public and private institutions to assist you, the teacher or facilitator in 

helping the learners meet the standards set by the K to 12 Curriculum while 

overcoming their personal, social, and economic constraints in schooling.  

This learning resource hopes to engage the learners into guided and independent 

learning activities at their own pace and time. Furthermore, this also aims to help 

learners acquire the needed 21st century skills while taking into consideration 

their needs and circumstances. 

In addition to the material in the main text, you will also see this box in the body of 

the module: 

 

 

 

 

 

 

As a facilitator you are expected to orient the learners on how to use this module. 

You also need to keep track of the learners' progress while allowing them to 

manage their own learning. Furthermore, you are expected to encourage and assist 

the learners as they do the tasks included in the module.    

 

 

 

 

 

 

 

 

 

 

 

Notes to the Teacher 

This contains helpful tips or strategies 

that will help you in guiding the learners. 
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For the learner: 

Welcome to the Empowerment Technologies Grade 11/12 Self-Learning Module 

(SLM) on Advanced Techniques using Microsoft PowerPoint! 

The hand is one of the most symbolized part of the human body. It is often used to 

depict skill, action and purpose. Through our hands we may learn, create and 

accomplish. Hence, the hand in this learning resource signifies that you as a 

learner is capable and empowered to successfully achieve the relevant 

competencies and skills at your own pace and time. Your academic success lies in 

your own hands! 

This module was designed to provide you with fun and meaningful opportunities 

for guided and independent learning at your own pace and time. You will be 

enabled to process the contents of the learning resource while being an active 

learner. 

This module has the following parts and corresponding icons: 

 
What I Need to Know  

 

This will give you an idea of the skills or 

competencies you are expected to learn in 

the module.  

 
What I Know  

 

This part includes an activity that aims to 

check what you already know about the 

lesson to take. If you get all the answers 

correct (100%), you may decide to skip this 

module.  

 
What’s In 

 

This is a brief drill or review to help you link 

the current lesson with the previous one. 

 
What’s New 

 

In this portion, the new lesson will be 

introduced to you in various ways such as a 

story, a song, a poem, a problem opener, an 

activity or a situation. 

 
What is It 

 

This section provides a brief discussion of 

the lesson. This aims to help you discover 

and understand new concepts and skills. 

 
What’s More 

 

This comprises activities for independent 

practice to solidify your understanding and 

skills of the topic. You may check the 

answers to the exercises using the Answer 

Key at the end of the module. 

 
What I Have Learned 

 

This includes questions or blank 

sentence/paragraph to be filled in to process 

what you learned from the lesson. 

 
What I Can Do 

 

This section provides an activity which will 

help you transfer your new knowledge or 
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skill into real life situations or concerns. 

 
Assessment 

 

This is a task which aims to evaluate your 

level of mastery in achieving the learning 

competency.  

 
Additional Activities 

 

In this portion, another activity will be given 

to you to enrich your knowledge or skill of 

the lesson learned. This also tends retention 

of learned concepts. 

 
Answer Key 

 

This contains answers to all activities in the 

module. 

 

At the end of this module you will also find: 

 

The following are some reminders in using this module: 

1. Use the module with care. Do not put unnecessary mark/s on any part of 

the module. Use a separate sheet of paper in answering the exercises. 

2. Don’t forget to answer What I Know before moving on to the other activities 

included in the module. 

3. Read the instruction carefully before doing each task. 

4. Observe honesty and integrity in doing the tasks and checking your 

answers.  

5. Finish the task at hand before proceeding to the next. 

6. Return this module to your teacher/facilitator once you are through with it. 

If you encounter any difficulty in answering the tasks in this module, do not 

hesitate to consult your teacher or facilitator. Always bear in mind that you are 

not alone. 

We hope that through this material, you will experience meaningful learning 

and gain deep understanding of the relevant competencies. You can do it! 

 

 

 

 

 

 

References This is a list of all sources used in 

developing this module. 
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What I Need to Know 

This module was designed and written with you in mind. It is here to help you 

master the Advanced Techniques using Microsoft PowerPoint. The scope of this 

module permits it to be used in many different learning situations. The language 

used recognizes the diverse vocabulary level of students. The lessons are arranged 

to follow the standard sequence of the course. But the order in which you read 

them can be changed to correspond with the textbook you are now using. 

The module has one lesson, namely: 

 Lesson 6 – Advanced Techniques using Microsoft PowerPoint 

After going through this module, you are expected to: 

1. describe terms, views, and functions of Microsoft PowerPoint; 

2. discuss the tips on how to make effective presentations; 

3. discuss how to add animation in a presentation; and 

4. explain the use of hyperlinks in a presentation. 
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What I Know 

Choose the letter of the best answer. Write the chosen letter on a separate sheet of 

paper. 

 

1. The shortcut key for inserting new slide. 
a. Ctrl + E 

b. Ctrl + H 

c. Ctrl + K 

d. Ctrl + M 

 

2. It is a readymade style that can be used for a presentation? 
a. Template 

b. Layout 

c. Presentation 

d. Merge 

 

3. It refers to the motion effects that occur in the Slide Show view when you 
move from one slide to the next during a presentation? 

a. Animation 

b. Custom Animation 

c. Transition 

d. Custom Slideshow 

 

4. This shortcut key is used to start a presentation from the beginning. 

a. ALT F4 

b. F5 

c. CTRL + ALT +F5 

d. ALT +F5 

 

5. The following are animation styles of Microsoft PowerPoint, except _____. 
a. Entrance 

b. Emphasis 

c. Exit 

d. Motion  
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Lesson 

6 
Advanced Techniques 
using Microsoft PowerPoint 

 

 

What’s In 

 

In our previous lesson, we have discussed that Microsoft excel provides an 

automated way of displaying any statistical data. It can be used to automatically 

compute for several factors that are not easy to notice especially when faced by a 

large data. Microsoft Excel includes several arithmetic and basic functions that 

help you compute faster. 

With Microsoft Excel, organizing and analyzing data are much simpler through  the 

use of conditional functions such as COUNTIF, AVERAGEIF, and SUMIF. These 

functions work almost the same as COUNT, AVERAGE, and SUM with the 

exception that you can provide criteria where if it is not met, the data is to be 

ignored by the formula. 
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What’s New 

 

4 Pics in One Word 

You will be presented with four pictures and guess the word that fits with the 

photos presented. Write your answer on a separate sheet of paper. 

1.   
 

2.  
  

3.  
 

4.  
 

5.  
 

1. _____________________________________________ 

2. _____________________________________________ 

3. _____________________________________________ 

4. _____________________________________________ 

5. _____________________________________________ 
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What is It 

Microsoft PowerPoint 

Microsoft PowerPoint is a powerful presentation software that helps you produce an 

effective presentation in the form of on-screen slides. It provides hyperlinks and 

several animation styles such as Entrance, Emphasis, Exit and Motion Paths. 

Animation and hyperlinks are great tools in making a presentation more dynamic. 

Terms, Views and Functions in Microsoft PowerPoint 

 Slide - is a single page of a presentation collectively, a group of slides may be 

known as a slide deck. The shortcut key to insert a new slide is Ctrl+M 

 

 

 

 Design Templates – are pre-designed graphic styles that you can apply to 

your slides. 
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 Slide Show Button - a collection of pages arranged in sequence that contain 

text and images for presenting to an audience. You may press F5 if you want 

to start your presentation from the beginning of the slides or you may click 

the slide show button  to display the current slide in the presentation. 

 

 Animation - is a set of effects which can be applied to text or graphics 

within a slide. 

 

 

 Transitions - are motion effects that when in Slide Show view add 

movement to your slides as you advance from one slide to another. 

 

 
 

 Presentation Views – These are the buttons that you use to change views 

into normal, outline, slide sorter, notes page, and reading views 
 

 

 Normal View – a simplified layout of the page so you can quickly key, edit, 

and format the text. 
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 Notes Page View - displays your slides on the top portion of the page, with 

the speaker notes for each slide in the notes pane on the bottom of the pane. 

 

 

 Outline View - displays all of the text in a PowerPoint slide show in outline 

form regardless of the design, objects and animations. 

 

 
 

 Slide Sorter View – allows you to see thumbnails of all the slides in your 

presentation to easily rearrange them. 
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Tips in Creating an Effective Presentation 

1. Minimize - Keep slide counts to a minimum to maintain a clear message 

and to keep the audience attentive 

2. Clarity - Use a font style that is easy to read 

3. Simplicity - Use bullets or short sentences 

4. Visuals - Use graphics to help in your presentation but not too many to 

distract the audience 

5. Consistency - Make your design uniform 

6. Contrast - Use light font on dark background or vice versa 

Sample Animation 

Create an animation where one person wants to pass the ball to another person.  

To add animation, do the following: 

1. On the first slide of your presentation, change the layout into a blank layout. 

To do this, follow the steps below: 

– Click the Home tab. 

– On the Slides group, click Layout. 

– Click Blank. 

2. Draw two objects in the form of a man using PowerPoint’s shapes. To do 

this, follow the steps below: 

– Click the Insert tab. 

– Click Shapes and select the appropriate shapes as shown on the 

figure using a black fill color for the two men, dark red for the ball 

and green for the rectangular ground.  

 
 

3. Right-click the slide thumbnail on the Slides pane and click Duplicate 

Slide. 

4. Move the right hand of the first man a little backward as shown below 
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5. Right-click the first slide thumbnail on the Slides pane and click Copy. 

6. Paste the slide after the second slide on the Slides pane. 

7. On the third slide, click the ball. 

8. Click the Animations tab. 

9. Click Add Animation and then select More Motion Paths. Add Motion Path 

dialog box will appear. 

      
 

10. Click Arc Up and then click OK. The motion path will look similar to the one 

below. Adjust the motion path such that the arrow is extended up to the 

hands of the second man. 

11. Make sure the motion path is still selected. Click Animation Pane on the 

Advanced Animation group. 

12. On the Animation pane, click the drop-down arrow on the Oval animation 

and then select Effect Options. 

 

To integrate timing, do the following: 

1. Click the Timing tab. 

2. On the Start drop-down arrow, click With Previous. 

3. Click OK. 

4. Click the first slide thumbnail.  

5. Click the Transitions tab. On the Timing group under Advance Slide, 

click After and select 00:01:00 (1 second). Make sure that the same 

timing is selected to the other two slides. 
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To check your output > Go to the first slide and click Slide Show view button.  

Hyperlinks in a Presentation 

Hyperlink allows you to easily navigate your slides during your presentation. It 

allows you to link to another slide in the current presentation, another slide in a 

different presentation, another file or webpage, or email address.  

 

Hyperlinks are usually activated by clicking on the text or image. Text 

hyperlinks are usually in color blue and underlined. When you use hyperlinks 

only the location of the source file is stored in the destination file, the linked 

data or file remains in the source file. The data in the destination file is updated 

whenever the source file is updated. 

To insert hyperlink, do the following: 

1. Select the text or object you want to insert a hyperlink to. 

2. Click the Insert tab. 

3. On the Links group, click Hyperlink. Insert Hyperlink dialog box will 

appear. 

To insert a hyperlink to another slide in the current presentation, do the 

following: 

a. Click Place in This Document. 

b. You may also add a text to display when you hover your pointer by 

clicking the ScreenTip button. Set Hyperlink Screen Tip dialog box 

will appear. 

To insert a hyperlink to another slide in the current presentation, do the 

following: 

a. Enter text to the ScreenTip text box. 

b. Click the slide where you want to link to under the Select a place in 

this document. 

c. Click OK. 
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To insert a hyperlink to another slide in a different presentation, do the 

following: 

a. Click Existing File or Webpage. 

b. Browse and select for the PowerPoint file. 

c. Click the Bookmark button. 

To insert a hyperlink to another slide in a different presentation, do the 

following: 

a. Click the slide where you want to link to under the Select an existing 

place in the document.  

b. Click OK.  

To insert a hyperlink to another file, do the following: 

a. Click Existing File or Webpage. 

b. Browse and select for the PowerPoint file. 

c. Click OK. 

To insert a hyperlink to a webpage, do the following: 

a. Click Existing File or Webpage. 

b. Enter the complete URL in the address text box. 

c. Click OK. 

To insert a hyperlink to an email address, do the following: 

a. Click E-mail Address. 

b. Enter the complete email address in the E-mail address text box. 

c. Enter the subject in the Subject text box. 

d. Click OK. 
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What’s More 

 

Name and describe the terms, views and functions shown in the picture. Write your 

answer on a separate sheet of paper. 

 

 

 

1.  
 

 

 

 

2.   
 

 

3.  

 
 

4.  

 
 

5.  

 
 

6.  
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7.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.  

 

 

 

 

 

 

 

9.  
 

 

 

 

 

 

10.  
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What I Have Learned 

 

In this lesson, I have learned that Microsoft PowerPoint is a very good example of a 

presentation software because it allows users to present information in a more 

engaging way. It also provides tools such as animation and hyperlinks that enable 

users to create dynamic presentations. Use hyperlinks if you want to easily 

navigate your slides during the presentation. With hyperlinks you can create links 

to an existing file or web page, a place in the document, create a new document, 

and send e-mail to a specified recipient. 

 

To create an effective presentation, minimize the contents to maintain a clear 

message, use fonts that are easy to read, use bullets or short sentences, do not 

flood the slides with text, avoid using visuals or graphics that can distract the 

audience, be mindful of the contrast, and be consistent on the design you use. 

 

 

 

What I Can Do 

 

Answer the following items and write your answer on a separate sheet of paper. 

1. List at least five real life situations where you can use Microsoft PowerPoint. 

 

2. What is the significance of using hyperlinks in your presentation? 

 

3. Cite three instances where animation styles are useful in presentations. 

 

4. Discuss the steps on how to add animation in a presentation. 
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Assessment 

Directions:  Read each item carefully, choose the letter of the correct answer. Write 

your answer on a separate sheet of paper.  

 

1. Luke wants to include videos in his presentation. He wants to play those 
videos without going out from his current presentation. Which of the 

following could be his best option? 
a. Use hyperlink to navigate those videos. 

b. Use another computer in playing the videos. 

c. Open the presentation and the videos to be played and then use Alt + 
Tab. 

d. Embed those videos as object in your slides. 
 

2. Which of the following statements is NOT true about a linked object? 

a. Linked object is stored in the source file. 

b. Information in the destination file doesn't change if you modify the 

source file. 

c. Information in the destination file is updated whenever the source file 

is modified. 

d. The data in the destination file changes whenever the source file is 

modified. 

 

3. Jethro was tasked to report a topic in one of his subjects. He wants to apply 

one of the hyperlink options where he could jump to a specific slide in his 
presentation. Which of the following hyperlink options will he use? 

a. Create a New Document 
b. Existing File or web Page 

c. Place in This Document  
d. E-mail Address 

 
4. Which of the following shortcut keys will you use if you want to start your 

presentation from the beginning of the slides? 

a. CTRL + F5 
b. SHIFT + F5 

c. F5 
d. F7 

 
5. The following are benefits of planning a presentation, except 

a. improves the quality of presentation 
b. saves time and effort 

c. makes presentation slightly effective 

d. makes presentation more enjoyable  
 

6. To make her presentation more effective, Kiana used different animation 

styles. Which of the following is NOT an animation Style? 

a. Entrance 
b. Emphasis 

c. Motion 
d. Exit 
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7. Evelyn would like to put motion effects on each slide in her presentation 

when she moves from one slide to the next slide. Which of the following 
features of MS PowerPoint will she use? 

a. Animation 
b. Custom Animation 

c. Custom Slideshow 
d. Transition 

 

8. Which of the following best describes a text hyperlink? 

a. color black and underlined 

b. color blue and underlined 

c. bold and underlined 

d. color blue and bold 

 

9. Which of the following statements is true about creating an effective 

presentation? 

a. Use as many slides as you can so that the audience can clearly 

understand your message. 

b. Use dark fonts on dark backgrounds to gain proper contrast. 

c. Use bullets to simplify your message. 

d. Use serif fonts to make your presentation more attractive. 

 

10.  A file which contains readymade styles that can be used for a presentation 
is _______ 

a. AutoStyle 
b. Template 

c. Wizard 
d. Pre-formatting 

 

11. The following are the buttons used for switching views, except 
a. Normal view 

b. Slide sorter view 

c. Slide show view 

d. Thumbnails view 
 

12. PowerPoint is best described as ________. 
a. Presentation software 

b. Database software 

c. Drawing software 

d. Publishing software 

 
13. The following are things to consider in creating an effective presentation, 

except 
a. Clarity 

b. Simplicity 

c. Consistency 

d. Creativity 
 

14. Which of the following is an easy way to navigate slides during your 
presentation? 

a. Use hyperlinks 

b. Flood your slides with text 
c. Use a mouse instead of arrow keys 

d. Press escape to locate the slides 
 

15. Marco used bullets and short sentences in his presentation. What tip in 
creating an effective presentation did he apply? 

a. Contrast  
b. Clarity 

c. Consistency 

d. Simplicity 
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Additional Activities 

 

Answer the following items in not less than three sentences. Write your answer on 

a separate sheet of paper. 

1. In your own perspective as a student, how important is Microsoft 

PowerPoint? 

_____________________________________________________________________

_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________

_____________________________________________________________________
_____________________________________________________________________ 

 
2. What are the benefits of using PowerPoint as a tool in the classroom? 

_____________________________________________________________________
_____________________________________________________________________

_____________________________________________________________________
_____________________________________________________________________

_____________________________________________________________________
_____________________________________________________________________ 

 

 

3. Make an acrostic out of the word POWERPOINT. 

_____________________________________________________________________

_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________

_____________________________________________________________________
_____________________________________________________________________ 
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Answer Key 

 

  
Assessment 

1.A 

2.B 
3.C 

4.C 
5.C 

6.C 

7.D 
8.B 

9.C 
10.B 

11.D 
12.A 

13.D 

14.A 
15.D  

 

What’s New 

1.PowerPoint 

2.Slide Show 
3.Design Template 

4.Animation 
5.Transition  

 

What I Know 

1.D 

2.A 
3.C 

4.B 
5.D 
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Telefax No.: (083) 2288825/ (083) 2281893 
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DISCLAIMER 

This Self-learning Module (SLM) was developed by DepEd 

SOCCSKSARGEN with the primary objective of preparing for and 

addressing the new normal. Contents of this module were based on 

DepEd’s Most Essential Learning Competencies (MELC). This is a 

supplementary material to be used by all learners of Region XII in all 

public schools beginning SY 2020-2021. The process of LR 

development was observed in the production of this module. This is 

version 1.0. We highly encourage feedback, comments, and 

recommendations. 


